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Abstract 

 The work on 3D-printing was continued from 2017 as summer internship work.  The result from this 
work was to streamline the process form heat exchanger geometry optimisation to generate control files 
for on-screen visualisation and 3D-editing and finally 3D-printing. 

The main outcome from this was to do the visualization scripting using Python and to couple this result 
to Paraview, a well known visualisation tookit often used with CFD. 

The summer internship report is included as is. 
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1. Introduksjon

Sommerprosjektet er en videreføring av fjor̊arets sommerprosjekt �Fra data til
fysisk modell�. Begge prosjektene omhandlet visualisering og 3D-printing av
varmevekslermodeller. Form̊alet er blant annet å kunne se hvordan varmveks-
lerne ser ut og om kompliserte geometrier er mulige å produsere ved hjelp av
3D-printing. Utgangspunktet for prosjektet er noen modeller laget i �Visualiza-
tion Toolkit� (VTK) med Tcl som programmeringsspr̊ak, hvor geometrien er
beskrevet av parametre som beregnes i simuleringer man finner i kodebasene
FlexHX og FlexCS.

Simon Høg̊asen, fjor̊arets sommerforsker, viste at 3D-printing av modeller
ikke er vanskelig i teorien. Dessverre var systemet for visualisering med VTK
i FlexHX vanskelig å sette seg inn i og tungt å bruke. Jeg har jobbet med å
forenkle og forbedre systemet framfor å utvikle nye modeller og mer funksjona-
litet. Resultatet av arbeidet er bedre støttede verktøy og mye mer oversiktlige
og brukervennlige systemer. Visualiseringsskript ble oversatt fra Tcl til Python.
Installasjon av visualiseringsverktøyet VTK ble forenklet og grundig dokumen-
tert. Det hjemmesnekrede redigeringsprogrammet for stl-filer ble erstattet av
Paraview. Modulen for å eksportere 3D-figurer i VTK til stl-format ble endret
slik at enorme figurer ogs̊a kan eksporteres (men kun til Paraview). Muligheten
for å kvitte seg helt med VTK til fordel for Paraview ble ogs̊a vurdert.
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2. Resultat

2.1 Installere VTK

Installasjon av VTK (Visualisation Toolkit) med msys, med støtte for Tcl og
Python, kan være vanskelig og tidkrevende. VTK er et stort verktøy, men man
kan kompilere en egen versjon som kun har funksjonaliteten man trenger. Dess-
verre kan kompilering ta mange timer. Uten god forst̊aelse for CMAKE og VTK
er det utfordrende å finne instillinger som ikke fører til kompileringskrasj og som
gir rett funksjonalitet.

Ettersom Tcl-kode har blitt oversatt til Python har installasjon blitt enkle-
re. Pacman i msys leverer vtk forh̊andskompilert med Python-wrapping og all
funksjonalitet n̊aværende modeller benytter. En full installasjonsguide finner du
i seksjon A.1. Ettersom Tcl er deprecated”, alts̊a ikke støttet i framtidige ver-
sjoner av VTK, har jeg valgt å ikke lage noen guide for hvordan man installerer
VTK med Tcl-wrapping, da dette uansett ikke kan brukes i framtiden. Hvis det
er et behov for å sjekke gamle tcl-modeller kan det være greit å installere en
gammel versjon av VTK som er forh̊andskompilert med tcl-wrapping.

2.2 Oversette Tcl til Python

Skript i Python og Tcl fungerer ganske likt. Å oversette modellene fra Tcl til
Python var derfor ikke spesielt vanskelig. Det krevde likevel noen dager da de
fleste kodelinjene ikke lot seg oversette direkte. I tillegg har flere modeller blitt
forenklet, forkortet og utnyttet innebygd VTK-funksjonalitet bedre.

Det er en flere grunner til at Tcl fases ut til fordel for Python. Python
har mye mer lettlest syntaks, mye større funksjonalitet, og det finnes alle slags
nyttige moduler/bibliotek lett tilgjengelig. Jeg vil anbefale p̊a det sterkeste å
bli kjent med det svært kraftige numeriske biblioteket numpy. Algoritmene er
skrevet i Fortran, s̊a det kjører svært raskt. Hvordan man kan bruke numpy
med VTK finnes det flere guider for p̊a internett.

For å forst̊a modellenes Python-kode skal det være nok med kjennskap til
grunnleggende python, VTK i Python-format og tkinter. Det er en stor fordel
å være godt kjent med �dictionaries�, da disse er mye brukt. Kode med bruk
av tkinter er dessverre vanskelig å lese, men man trenger heldigvis ikke forst̊a
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alt for å bruke det. Modellene er skrevet slik at de fungerer i b̊ade python 2 og
3. Det er noen f̊a men viktige forskjeller mellom de to versjonene som er greit
å være kjent med. Heltallsdivisjon, xrange, tkinter vs Tkinter, for å nevne noe.
VTK og Paraview bruker Python 2 som standard foreløpig. Begge versjoner
støttes, men det jobbes mot å kun bruke Python 3 en gang i framtiden.

2.3 Bygge egen GUI

En GUI, �Graphical User Interface�, laget med tkinter ble utviklet for modellen
vtkhx. Målet var å se om det ble lettere å jobbe med de tyngste modellene hvis
variabler og figurer kan endres p̊a interaktivt. Det tok undertegnede en god del
tid å lære seg tkinter skikkelig, men s̊a snart man har kontroll p̊a funksjonalitet
og syntaks g̊ar det kjapt å utvikle en GUI. GUI-en som ble laget for vtkhx gjør
det mulig å skru av og p̊a enkelte figurer, redigere oppløsning og antall finner, og
lagre modellen til stl slik du ser den. Det viktigste for å oppn̊a slik funksjonalitet
er at hver figur er én �actor� og at pipeline (se seksjon 3.1) er intakt slik at
data kan modifiseres. Generelt er dette gode retningslinjer for å lage fleksibel
kodei VTK.

2.4 Legge til visualisering i FlexHX/FlexCS

Simuleringene i FlexHX/FlexCS har f̊att automatisert generering av visualise-
ringsskript som enkelt kjøres med kommandoen vtkpython ¡navn p̊a skript¿.
Resultatet er forenklet arbeidsflyt for testing og visualisering som kan kjøres
uten spesiell kunnskap om VTK. Nye Python-modeller ligger i biblioteksmap-
pa, /libs/, i FlexHX og er koblet opp til noen simuleringer i b̊ade FlexHX og
FlexCS. Hvordan modellene flettes inn i FlexHX er beskrevet i seksjon A.2.
Forh̊apentligvis vil dette gjøre det enkelt å legge inn visualisering i alle simule-
ringer, og mulig å bruke for de som ikke er utviklere av visualiseringsmodellene.
Systemet er ganske stort og litt uoversiktlig, s̊a det kan være en ide dokumen-
tere/systematisere/rydde bedre framover.

2.5 Eksportere figurer og klipping

For å kunne 3D-printe figurer m̊a de eksporteres i et universelt dataformat som
andre programmer støtter. Forrige sommerforsker skrev kode for eksport i stl-
format. I lagringsfunksjonen velger man lag, slik at figurene (actor-ene) som
lagres i samme lag blir skrevet til samme stl-fil. Hvert lag blir en egen fil.

Iløpet av dette prosjektet har koden blitt oversatt til python, men med utvi-
det funksjonalitet for lagring av modeller som benytter glyphing (se seksjon 3.2
om glyphing). I koden kan man velge mellom 2 alternativ. Det ene alternativet
er vanlig lagring hvor hele figuren skrives til en stl-fil. Det andre alternativet er
å lagre glyph-punktene i en egen vtk-fil og kun ett glyph-element til stl. Ved
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store figurer m̊a man lagre p̊a sistnevnte m̊ate, ellers blir resultatet enorme og
ubrukelige stl-filer. Merk at vtk-format kun kan åpnes i VTK eller Paraview.

Med store og kompliserte modeller er det som regel mest aktuelt å 3D-printe
et begrenset utsnitt. Dette krever klippefunksjonalitet som ogs̊a vanntetter mo-
dellen etter klipping. Forrige sommerstudent lagde et eget program for klipping.
Problemet er at det mangler funksjonalitet for glyphing, er lite stabilt og m̊a ma-
nuelt oppdateres for framtidige versjoner av VTK. Ettersom Paraview har mye
kraftigere funksjonalitet, er relativt lett å bruke og enkelt å installere var det
logisk å forkaste det hjemmelagde systemet. Guiden i seksjon A.3 viser hvordan
man åpner de eksporterte filene i Paraview og hvordan man klipper/behandler
figurene for å lage et utsnitt som kan 3D-printes.

2.6 3D-printing

Det ble printet en 3D-print av �pfhelayers� som er vist i figur 2.1 for å vise
at systemet med klipping i Paraview fungerer. Et materiale kalt breakaway ble
s̊avidt testet ut mot slutten av prosjektet. Det er mye lettere å løsne enn vanlig
materiale, slik at mye av problematikken med overheng kan kanskje løses. Ellers
har ikke 3D-printing blitt nevneverdig utforsket iløpet av prosjektet. Fjor̊arets
erfaringer siteres i seksjon 3.4 for å beskrive status og forbedringspotensial rundt
3D-printing.

Figur 2.1: 3D-printet utsnitt fra modellen pfhelayers.

5



3. Diskusjon

3.1 Pipeline

I VTK har du s̊akalte pipelines. Dette er et konsept det lønner seg å ha god
forst̊aelse for n̊ar man jobber med VTK. En pipeline kobler sammen ulike lag,
fra rene punktdata opp til det som vises p̊a skjerm. En pipeline i VTK ser slik
ut: punkter->geometri->filter->mapper->actor

Hvordan man kobler pipeline i kode er ofte en utfordring. Hvert lag er koblet
til hverandre ved å lage koblinger, for eksempel minMapper.setInputConnection(�ar-
gument�), der argumentet kan være mittFilter.GetOutputPort() eller
mittFilter.GetInputConnection(1, 0). Det blir fort fristende å finne mer lettles-
te m̊ater å programmere p̊a, for eksemepl minMapper.SetInputData(�data�).
Denne funksjonen vil jeg imidlertid sterkt frar̊ade noen å bruke (hvis man ikke
vet nøyaktig hva man gjør) ettersom denne funksjonen ikke kobler dataene via
en pipeline. Det vil si at datasettet mapperen tar inn ikke kan endres i ettertid.
Mangelen p̊a sammenkobling/�referencing� gjør koden mindre fleksibel. Ved
programmering i VTK lønner det seg alts̊a å skaffe seg grunnleggende forst̊aelse
for pipleline for å spare tid p̊a sikt.

3.2 Glyphing og god bruk av filter

For å kunne bruke VTK effektivt bør man kjenne til hvilke filter som fins. Filter
hjelper med redigere objekter effektivt, for eksempel omdanne en linje til et rør
med 3 korte kodelinjer. Det er fort gjort å streve lenge med å lage objekter
manuelt selv om det allerede finnes et filter som gjør jobben. Ikke gjør det.

Det viktigste filteret for store visualiseringer er glyphing. Uten glyphing vil
visualiseringer med mange punkter bli fryktelig trege eller ubrukelige. Et glyph-
filter har 2 inputs. En kildefigur, f.eks. en kule, og et sett med punkter. Output
blir da en figur med en kopi av kulen i hvert spesifiserte punkt. Glyphing er
alts̊a kopiering av figurer. Helst bør du bruke vtkGlyph3DMapper(), alts̊a en
mapper og ikke filter. Glyph-filteret er mye tregere enn mapperen (bruker CPU
i stedet for GPU). Filteret og mapperen fungerer nesten helt likt ellers.

Selvlagd geometri med polydata kan gi figurer som ikke vanntett. Dette kan
skyldes at en flate mangler, som kan skje hvis punkter ikke er koblet riktig
sammen. Eksempel p̊a et objekt som ikke er vanntett ser du i figur 3.1. Lukket

6



klipping og 3D-printing krever vanntette objekter. 3D-builder eller tilsvarende
programmer kan vanntette objektene for deg, men det beste er å lage vanntette
modeller i utgangspunktet. Det burde g̊a fint med polydata s̊a lenge man kobler
sammen punktene p̊a rett m̊ate og sjekker vanntetthet med klipping.

Figur 3.1: Visualisering av pfhelayers etter klipping uten lukking. Resultatet er
en �̊apen�, ikke vanntett, figur.

3.3 Paraview kan og burde erstatte VTK

Paraview tilfører mye nyttig funksjonalitet som VTK ikke har. Titalls timer av
prosjekttid har allerede g̊att til å utvikle funksjonalitet i VTK som er innebygd
i Paraview. Argumentene for å skifte til Paraview er mange.

En utfordring med å skifte verktøy er at eksisterende VTK-kode m̊a skrives
om til Paraview-kode. I teorien burde ikke denne overgangen være stor, ettersom
Paraview er bygd p̊a VTK. Det vil bli færre linjer kode, ettersom fokuset blir
utelukkende p̊a modellene og ikke hvordan man f̊ar dem opp p̊a skjerm.

I tillegg til fordelene som beskrives i figur 3.2 er det verdt å nevne at Paraview
er betydelig lettere å installere enn VTK, og det er ikke noen vanskeligheter
med �PATH� eller konflikter med andre program, for eksempel diverse python-
installasjoner. Blir �FPS� for lav (oppdateringsfrekvens til visualisering) p̊a
grunn av tunge modeller kan den miste interaktiviteten. I vtkhx ble det forsøkt å
innføre LODactorer som reduserer detaljer for å øke �FPS� mens man forflytter
bildet. I Paraview genereres LODactorer automatisk hvis �FPS� blir for lav.
Dette er bare noe av det Paraview fikser for deg. Over tid vil det alts̊a lønne seg
å gjøre den nødvendig innsatsen som trengs for å erstatte VTK med Paraview.
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Figur 3.2: Utdrag fra poster til sommerforskerkonferanse. Omhandler fordeler
med Paraview mot ren VTK.
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3.4 Fjor̊arets erfaringer med 3D-printing

Denne seksjonen best̊ar hovedsakelig av et utdrag fra fjor̊arets rapport, �Fra
data - til fysisk modell� av Simon Høg̊asen. Utdraget er en god beskrivelse av
hvordan 3D-printing fungerer og hva man bør jobbe med framover:

3D-skrivere for plast leser vanligvis et filformat som kalles �gco-
de� som har litt ulike implementasjoner avhengig av skriveren. Kort
beskrevet er denne koden et sett med instruksjoner som forteller hvor
skriverhodet skal bevege seg, hvilke temperaturer som skal settes og
n̊ar det skal sendes ut plast. For å komme fra en 3D-modell til gcode,
bruker man en �slicer�. Det er et program som deler opp modellen
i tynne lag og finner ut hvordan skriverhodet skal bevege seg for å
legge plast p̊a de rette stedene. N̊ar lagene skrives ut p̊a hverandre,
blir resultatet en 3D-modell.

3D-skriveren som er brukt i prosjektet er en Ultimaker 3, og den
anbefalte �slicer�-en til denne skriveren heter Cura. Programmet
importerer 3D-modeller i et lite utvalg formater og produserer gcode-
filer som senere kan leses av skriveren. Programmet har mulighet for
direkte oppkobling mot skriveren over et nettverk, eller man kan
overføre filene med en USB-minnepinne. Siden programmet utvik-
les av produsenten av 3D-skriveren, gir standardinnstillingene gode
resultater. Det hadde likevel vært nyttig å sammenligne resultatet
fra andre �slicer�-e. Cura fungerer godt dersom man har en modell
som kan importeres og deretter skrives ut direkte, og gir god kontroll
over innstillingene til skriveren. Programmet kan sette sammen flere
komponenter til en modell, men egner seg ikke like godt til mer sam-
mensatte modeller. Hvis flere komponenter skal importeres, lønner
det seg at de allerede er skalert og beskrevet relativt til et felles
origo. Bedre valgmuligheter for å generere støttestrukturer vil ogs̊a
være ønskelig, og er tilgjengelig i andre, tilsvarende programmer,
men ingen av alternativene har blitt testet i dette arbeidet.

3D-modeller bør være sammenhengende og ha lite nok overheng for å
gi gode resultater. Cura forventer lukkede flater med definert innside
og utside, og genererer feil gcode hvis modellen har flater som ikke
er det. Ved å sette innstillingen �Surface mode� til �Surface� el-
ler �Both�, og å velge �Spiralize outer surface�, kan modeller som
bare best̊ar av enkeltflater skrives ut ved at skriveren følger disse
flatene. Ulike kombinasjoner av disse to innstillingene gir litt ulike
resultater. Overheng blir generelt bedre med lavere skrivehastighet,
men uten støttestrukturer er overheng en viktig begrensning. I ge-
nererte modeller som ikke er veldig presise, hadde det vært gunstig
med bedre, automatisk oppretting. En vurdering av verktøy som kan
gjøre dette kan være interessant.
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4. Konklusjon

Det viktigste for å lage gode visualiseringer effektivt er å ikke gjenoppfinne
hjulet. Sommerprosjektet har dermed hatt som fokus å teste ut forskjellige
programmer for å gjøre utviklingsprosessen enklere, og dermed raskere. Bedre
støttet programmeringspr̊ak, Python, bidrar ogs̊a til dette. For videre forenkling
er neste steg å innføre Paraview. Dette kraftige programmet har funksjonalitet
som dekker alle steg fra data til 3D-printbar modell. Slik det er n̊a skal systemet
være forenklet nok til at alle p̊a prosjektet kan benytte seg av visualiseringsmo-
dellene. Med Paraview og videre forenkling blir terskelen for å lage nye modeller
forh̊apentligvis s̊a lav at flere prosjektmedlemmer kan lage modellene de vil ha.

En naturlig videreføring av prosjektet vil være å...

• sette seg grundig inn i Paraview.

• gjøre vtkhx om til en komplett modell.

• rydde i FlexHX (erstatte tcl-filer, dokumentere filsystem, etc.).

• lage nye, mer komplekse modeller.

• videre utforske muligheter rundt 3D-printing.
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A. Selvlagde guider

A.1 Installere VTK med Python

# Installing VTK with msys2 and mingw-w64 for windows 64-bit
Total installation time: 30-90 min (a good internet connection is

useful)

Install msys2 with mingw-w64 at root
Download site and installation procedure can be found at:
https://www.msys2.org/

Update all packages like the installation manual says..

Installation of vtk and python2 with pacman:

Msys packages:
a. pacman -S make
b. pacman -S diffutils
c. pacman -S vim (text editor which includes xxd)

##############################
####### BUG FIX ############
##############################
PROBLEM: tcl/tk version 8.6.8 seems to be broken.
NOTE: Do this right after installing Mingw package a) (the mingw

toolchain), and before package b)

Download older version, e.g. from
https://sourceforge.net/projects/msys2/files/REPOS/MINGW/x86_64/
or get the files from someone you know have them.
I installed tcl 8.6.7, with filename:
mingw-w64-x86_64-tcl-8.6.7-1-any.pkg.tar.xz
and tk 8.6.7, with filename:
mingw-w64-x86_64-tk-8.6.7-1-any.pkg.tar.xz
(downloaded from sourceforge)

Run "pacboy -R -c tcl:x" to remove current version of tcl and tk
Install both tcl and tk with "pacman -U <pkg_location>/<pkg_name>")
You can (and should?) reinstall gdb afterwards (includes python3).
pacboy -S gdb:x
##############################

Mingw packages:
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a. pacboy -S toolchain:x (select all as default)
b. pacboy -S dlfcn:x
c. pacboy -S gsl:x
d. pacboy -S openblas:x
e. pacboy -S libmariadbclient:x
f. pacboy -S postgresql:x (this should include python2.7)
g. pacboy -S vtk:x (takes alot of time and space to install!!!

Note to self: Can qt5 be skipped?

After installation change line 34 in vtkLoadPythonTkWidgets.py to
"elif os.name == ’posix’ or sys.platform == ’win32’:"
For me the file was located inside this folder:
C:\msys64\mingw64\lib\python2.7\site-packages\vtk\tk\

In your home directory in msys (C:msys64/home/<user_name>) you’ll have
a hidden file, .bashrc

Open .bashrc in a text editor and add the following to the end of the
file:

#Start
alias vtkpython=/mingw64/bin/vtkpython

export PYTHONHOME=/mingw64/lib/python2.7
export PYTHONPATH="$PYTHONHOME:$PYTHONHOME/site-packages:$PYTHONHOME/

lib-dynload:${PYTHONPATH}:$PYTHONHOME/lib-tk:$PYTHONHOME/site-
packages/vtk"

export PATH="${PYTHONPATH}:/mingw64/bin:/mingw64/lib:${PATH}"
#End

Note that other python dependent packages, e.g. mercurial, might not
work with the new pythonpath.

Consider creating a script which runs specifically vtkpython with these
paths.

####### TESTING ##############

Open a new mingw64 shell and try to run vtkpython.
This should open a python2.7 shell.

Write the following:
import vtk
import Tkinter
from vtk.tk.vtkTkRenderWindowInteractor import *

If no errors appeared your installation should work!

By adding vtk libs to path, a pure python shell should be able to run
vtk as well

####### EXTRA ##############

pacman also delivers gnuplot and graphviz
pacboy -S gnuplot:x
pacboy -S graphviz:x
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A.2 Legge visualiseringsskript inn i FlexHX

Making a VTK template in python for flexhx

Variables should be stored as pure variables
or dictionaries at the top of the file.

After creating a visualization model:
1. Remove/comment out test variables on top
2. Save template to <somefolder>/flexhx/lib/
3. Add target to Makefile (xxd)
4. Add vtktemplate to objects.lst
5. Make a function that creates a full script (variables and template)

a. Find correct source file, e.g. /src/fhxvtk.c
b. Make a function that acquires and writes the variables
c. Add template at the bottom (loop through all symbols from xxd)

6. Apply function to your model
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A.3 Fra visualisering til 3D-print

Open your vtk output files (.stl and .vtk)
File -> Open -> <your files>

GLYPHING
When glyphing you will have both .stl and .vtk for each actor.
The .stl is a single glyph. The .vtk sets glyph locations.
To combine these data in Paraview, do the following:

0. If necessary: Make .stl-files waterproof in windows 3D-builder
1. Open the .stl and the corresponding .vtk
2. Select the .vtk and select (in toolbar):

Filters->Alphabetical->Glyph With Custom Source
3. Choose the vtk file as input and stl file as glyph type.
4. Select your new "GlyphWithCustomSource".

Set "Scale Factor" to 1. Set "Glyph Mode" to "All Points".

Please update this guide if you figure out a way to make the settings
under point 4. the default settings for "Glyph With Cusrom Source".

CLIPPING
Filter -> "Clip closed surface"
Under properties you can choose plane to clip, offset, etc.
Don’t use the normal clipping function. It does not close the surface,

which is needed for 3D-printing.

Note for 3D-printing:
Figures created with polydata might not be waterproof.
Not waterproof -> clipping cannot close object
3D-builder (windows program) can "fix" (waterproof) your .stl polydata

object.
Replace the old .stl in Paraview.

TIPS:
Download the Paraview guide and read up on how to navigate
Save state often. Paraview crashes frequently.
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